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Chapter 1: Introduction to integrations
xMatters On-Demand reduces incident response time by finding the right person to solve the problem when system
outages require you to manage on-call schedules and escalations.

l Reduce downtime: create and automate critical incident processes to get the right people on the job.
l Aggregate and consolidate alert views: closed loop integration between xMatters and HP Service Manager
provides a single view of all alerts, no matter how diverse and distributed your environment may be.

l Engage resolution teams: determine message recipients based on on-call schedules, including substitutions
and holidays, specific skill sets, escalation priority, and more.

l Avoid alert fatigue: reduce the noise with targeted notifications; alerts go only to the people that need them.
l Manage issues from anywhere: full-featured mobile apps allow you to stay in control wherever you are.

Through communication plans, xMatters can become the voice and interface of an automation engine or intelligent
application. When a management system detects something that requires attention, xMatters places phone calls,
sends messages, or emails the appropriate personnel, vendors, or customers.

xMatters is also persistent, escalating through multiple devices and personnel until someone accepts responsibility or
resolves the problem. Once contacted, xMatters gives the notified person instant two-way communication with the
management system. Responses are executed immediately on the original management system event, enabling
remote updates and resolution.

During the process, every notification, response, and action is logged in xMatters. In addition, xMatters
automatically annotates the original event with status information.

1.1.1 Information workflow
The following diagram illustrates a standard workflow in an incident management system, and how information from
the management system is passed into xMatters:

1.1.2 Integration architecture
The software components in this integration include:
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l xMatters On-Demand
l HP Service Manager Incident Management
l xMatters integration agent

The following diagram illustrates the software processes used by this integration:

Whenever HP Service Manager detects a problem, it triggers the following steps (for a description of what will cause an
event to be injected into xMatters, see "Event injection triggers", below):

1. HP Service Manager sends the event details to the xMatters integration agent via HTTP POST.
2. The integration agent forwards the event details to xMatters via the REST API.
3. The response returns to the integration agent.
4. The integration agent sends the response to HP Service Manager via web services.

User and group synchronization process
As illustrated in the diagram, event injection for this integration is handled via the xMatters integration agent. User and
group synchronization, however, is handled via direct web service calls between xMatters and HP Service Manager. For the
user and group synchronization process to work, the web services user must be properly configured, as described in "Adding
the web service and REST API users" on page 6.

Event injection triggers
The following is a summary of the circumstances under which HP Service Manager will inject an event into xMatters for
notification. Note that this is the default, out-of-box behavior, and may be configured differently for some deployments.

l An event will be injected into xMatters whenever a new record is created with a Priority of "Critical" or "High".
l An event will also be injected into xMatters whenever one of the following changes is made to an existing record:

l the incident Priority is upgraded to "High" or "Critical" (Priority Upgrade);
l the incident becomes a "hot" ticket (Priority Upgrade);
l the incident status is changed back to "Open" (i.e., the ticket is reopened);
l the "High" or "Critical" incident is resolved (Ticket Resolved); or
l the "High" or "Critical" incident is assigned to another user (Assignment).
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If the currently assigned user is the one making the changes, the event will still be injected, but the recipients will not be
assigned. This allows subscribers to be informed, but the assignee will not be targeted for notification. This is also true if the
incident is closed.

Note: Clients can customize this behavior by modifying the appropriate sections in the AlarmPointEvent script in the HP
Service Manager Client.

With terminations, the normal approach is for an event to be terminated in xMatters if it is superseded by a new event for the
same incident. Terminations can also occur via notification responses. For example if an incident is resolved from the
notification, the notification is terminated and all users are delinked. (For more about responses and the effect on workflow,
see "Response choices" on page 34.)

1.2 System Requirements
The following component versions are supported by this integration.

Integration Component Version

xMatters On-Demand 5.5.80 (or later)

xMatters integration agent 5.1.5 (or later)

HP Service Manager Incident Management 9.3.4 OR 9.4

For more information about the supported operating systems for xMatters On-Demand, refer to the xMatters installation and
administration guide and xMatters integration agent guide

1.3 Conventions and Terminology
This section describes how styles are used in the document, and provides a list of definitions.

1.3.1 Conventions
Some instructions appear in the following format: MENU > OPTION; for example, File > Open means click the File menu,
and then click the Open menu option.

Words in bold typically reference text that appears on the screen. Words in monospace font represent the following:

l text that must be typed into the computer
l directory and file names
l code samples

Directory paths
Except where explicitly stated, the directory paths in this document are listed in Windows format. Unix users must substitute
the given paths with the Unix equivalents.

The xMatters integration agent installation folder is referred to throughout the documentation as <IAHOME>.

l On Windows systems, the default is C:\Program Files\xmatters\integrationagent

l On Unix systems, the default is /opt/xmatters/integrationagent

1.3.2 Terminology
The following terms are used through the xMatters documentation.
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Term Meaning

Event An event refers to any situation or item of interest detected by the management system, and which
requires attention. Event is also used to refer to the incident or situation as it progresses through the
xMatters system, from injection to notification to resolution. Each event must generate at least one
alert or notification.

Event can also be a generic term used to refer to an incident, change request, message, or other
specific item within the management system. Whenever possible, these situations are referred to
using the management system's preferred terminology, but can also collectively be called events.

Management system A management system is any sort of monitoring or managing software that watches for events, and
with which xMatters can combine; i.e., a synonym for HP Service Manager.

Device The medium through which a recipient is contacted by xMatters. This could be an email address,
pager or phone number, or even the xMatters app on a smart phone.

User In xMatters, people who can receive notifications are called "users". Each person in the xMatters
system is defined by a set of user details, including ID number, user name, login password, and so
on.

Group Groups are used to collect and organize users and devices into notification schedules. For a
complete explanation of Groups in xMatters, see the xMatters user guide.

Documentation terminology
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Chapter 2: Installation and Configuration
This chapter provides information about installing the xMatters for HP Service Manager Incident Management integration.
This chapter also contains complete instructions on how to configure xMatters, HP Service Manager, and the integration
components.

2.4 Configuring xMatters
Before you can configure xMatters for the integration, you need to download and extract the integration components.

To install the integration components:

1. Extract the integration archive file (.zip or .tar.gz) to a location on the computer hosting the integration agent.

The following table describes some of the notable components in the integration archive file:

Component Name Description

xMattersSyncConfig.xml Contains all the groups, teams, users, devices and coverage value mappings
used when synchronizing HP Service Manager operators and assignments with
xMatters users and groups.

xMattersSyncList.xml Contains a list of all of the HP Service Manager operators and assignments to
either include or exclude from synchronization with xMatters.

xMattersForms.sc
xMattersScriptLibrary.sc
xMattersTriggers.sc
xMattersUnload.sc
xMattersWebService.sc

HP Service Manager unload files used to import the custom xMatters records
and tables.

HPSMIM.zip Contains a pre-formatted, exported communication plan and the necessary
forms.

HPSMIMIntegratedProperties.zip Contains a pre-formatted, sample communication plan and form designed for
the integrated properties feature.

hpsmim.js
hpsmim-events.js
hpsmim-callbacks.js
hpsmim-properties.js
xmrestapi.js

Contains the JavaScript code to support the calls from HP Service Manager to
the integration agent when injecting events into xMatters.

hpsmim.xml
configuration.js

Contains the configuration information for the integration agent and
integration.

Integration components

2.4.1 Installing voice files
These files must be installed into any xMatters deployment using voice devices. For more information, refer to the xMatters
installation and administration guide.

This integration provides a number of English voice files (.vox) customized for this integration and HP Service Manager. The
files are located in the /components/xmatters/vox folder in the extracted integration archive.
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To install the voice files:

1. Log in to xMatters as a company administrator.
2. Click the Developer tab.
3. In the Phone Recordings menu, click Add Phone Recording.
4. On the Add a Phone Recording page, specify the following settings:

l Recording Phrase: A HP Service Manager Incident
l Event Domain: applications

5. Click Save.
6. On the Edit Phone Recording Details page, click Add New.
7. On the Add Phone Recordings page, click Choose File.
8. Navigate to \components\xmatters\vox, and select A HP Service Manager Incident.vox.

Note: The names of the recordings you type into the web user interface MUST match the names of the files; file names are
case-sensitive, and spacing must be respected.

9. Click Open.
10. Click Save.
11. Repeat steps 3-10 for each of the remaining .vox files in \components\xmatters\vox.

l Ensure that all files are added to the applications event domain.

2.4.2 Adding the web service and REST API users
This integration requires a dedicated web service user and a separate, specially-configured user with permission to access the
xMatters REST API.

Adding the web service user
This integration requires an xMatters web service user with permission to receive APXML in xMatters to receive user
responses and notifications about event status changes. The following steps describe how to configure the default web service
user, IA_User, for this integration.

To set up a web service user:

1. Log in to xMatters, click the Users tab, and then click Find Web Service Users.
2. On the Find Web Service Users page, click All.
3. In the returned search results, click IA_User.

l If the IA_User does not exist, click the Add New Web Service User link to create a new web service user.
4. On the Details for IA_User page, confirm that the list of Allowed Web Services includes the following web services.

(If any are missing, select them in the Denied Web Services list, and then click Add):
l Query User
l Receive APXML
l Register Integration Agent
l Submit APXML

5. Click Save.

Adding the REST API user
To send, delete, and query events, the integration requires a separate xMatters user with permissions to access the integration's
forms. By default, users with the Full Access User role have these permissions. To change this (for example, to limit the
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access to a specific user), you can modify form permissions.

To set up a REST API user:

1. In the xMatters web user interface, click the Users tab.
2. Click Add User.
3. On the Add a User page, specify the following settings:

l User ID: Type a user ID for the REST API user; the default is "hpsmim". (This value will also be configured as
INITIATOR in the configuration.js file.)

l First Name: HP Service Manager
l Last Name: Incident

4. Select Full Access User from the Available Roles list, and then click Add.
l The role you select must match the role configured under Permissions in the integration form.

5. Click Save.
6. On the Change Web Login page, specify the following settings:

l Web Login ID: Enter a web login ID for the REST API user; the default is "hpsmim". (This value will also be
configured as INITIATOR in the configuration.js file.

l New Password and Verify New Password: Type the web login password (this password will also be encoded in
the configuration.js file).

7. Click Save.

2.4.3 Importing communication plan
The integration package includes a .zip file that was created using the xMatters "Export Plan" feature; this greatly simplifies
the configuration process by enabling you to create the integration communication plan, forms, event properties, and
responses in a single step.

To import the integration communication plan:

1. Log in to xMatters as a company administrator, and click the Developer tab.
2. In the Manage Communication Plans menu, click Import Plan.
3. In the Import Communication Plan File dialog box, click Choose File, and then locate the

\components\xmatters\plan\HPSMIM.zip file extracted from the integration archive.
4. Click Open, and then click Import Plan.
5. Click Plan Disabled to enable the plan.
6. In the Edit drop-down list, select Forms.
7. In the Incident Assigned Alert form, in the Not Deployed drop-down list, click Create Event Web Service.

l After you create the web service, the drop-down list label will change to "Web Service Only".
8. In the Web Service Only drop-down list, click Permissions.
9. Enter the REST API user you created in "Adding the web service and REST API users" on page 6.
10. Click Save Changes.
11. Repeat steps 7-10 for the remaining forms.
12. When you have finished deploying and permissioning the forms, review the form properties to make sure the values

match your HP Service Manager configuration.

Accessing web service URLs
To get the web service URL for a form, in the Web Service Only drop-down list, click Access Web Service URL. Copy the
highlighted URL at the top of the dialog box.
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Note: The Access Web Service URL option may appear twice in the drop-down menu. Ensure that you click the option just
below Create Event Web Service.

Specifying a default recipient
Most events generated by this integration are designed to be subscription-only, meaning the recipients for each event are not
specified in the event details. To ensure that the system does not attempt to generate any events without recipients, you
should specify a default recipient for each form. This recipient will always be notified, even if your subscriptions do not
target anyone.

To add a recipient, open each form's Layout tab and add at least one recipient (a user with a valid, active device, or a non-
empty group) to the Recipients section.

Note: The Error Alert and Sync Error Alert forms do not require default recipients.

2.4.4 Defining custom fields
This integration uses custom fields defined in xMatters to obtain authentication credentials for submitting notification
responses and annotations to HP Service Manager. These custom fields enable the response option list to be displayed on
notifications.

By default, the custom fields are “HP SM Login” and “HP SM Password”; it is strongly recommended that you use these
default field names.

Note: If you have already installed the HP Service Manager Change Management integration, you do not need to perform
this step.

To define the custom fields:

1. In xMatters, click the Admin tab, and then, in the Administration menu on the left side of the screen, click Custom
Fields.

2. Click Add New, and then enter the following information into the form:
l Field Name: HP SM Login
l Type: Text

3. Click Save.
4. Click Add New, and then enter the following information into the form:

l Field Name: HP SM Password
l Type: Password

5. Click Save.

Note: For more information about custom fields, see the xMatters installation and administration guide.

2.4.5 Configuring users
Each xMatters user that will be notified and respond to notifications must be configured to allow xMatters to communicate
with HP Service Manager as that user. Each user must also be configured in HP Service Manager, as described in "Adding
capabilities to users" on page 15.

Note: If you have already installed the HP Service Manager Change Management integration, you do not need to perform
this step.
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To configure a user:

1. In xMatters, click the Users tab.
2. Use the Find Users page to locate the user you want to configure and view their details.
3. In the Common Tasks pane, click User Devices.
4. Verify that an appropriate device exists and that it is enabled.
5. Click Save.

2.4.6 Creating an admin group
If a synchronization error occurs and the send_sync_error_notification configuration variable is set to true in the
AlarmPointConfig script, then a notification is sent out to the recipient defined in the default_xmatters_admin_group variable
in the AlarmPointConfig script. The default value is set to "companyadmin".

l If you do not want notifications to be sent out due to synchronization errors, set the send_sync_error_notification
variable in the AlarmPointConfig script to false.

To configure the HP Service Manager admin group, click the Groups tab in xMatters, and create a new group named SM
Admin, with at least one user as a team member to receive notifications. Update the default_xmatters_admin_group variable
in the AlarmPointConfig script with the name of the new group.

Note that if you have already installed the HP Service Manager Change Management integration, you do not need to do this
step.

Note: For more information about creating groups and teams, see the xMatters user guide.

2.4.7 Installing the integration service
To install the integration service, you must perform the following steps:

l Copy the folder containing the integration components into the integration agent; this process is similar to patching the
application, where instead of copying files and folders one by one, you copy the contents of a single folder directly
into the integration agent folder (<IAHOME>). The folder structure is identical to the existing integration agent
installation, so copying the folder's contents automatically installs the required files to their appropriate locations.
Copying these files will not overwrite any existing integrations.

l Modify the integration agent's IAConfig.xml file to include the path for the new integration service.
l Modify the variables in the configuration.js files associated with the integration services.

If you have more than one integration agent providing the HP Service Manager service, repeat the following steps for each
one.

Note: If you have already installed an existing integration, ensure that you back up the deduplicator-filter.xml file
(if one exists) in the <IAHOME>\conf folder before you install this integration. 

To install the integration service:

1. Copy all of the contents of the \components\integration-agent folder from the extracted integration archive to the
<IAHOME> folder.

2. If you backed up an existing deduplicator file as indicated in the note above, merge the contents of your backup with
the newly installed <IAHOME>\conf\deduplicator-filter.xml file: open both files in a text editor, and then copy
the <filter> node from the backup file into the new deduplicator file after the last </filter> node. Save and close the
file.

3. Open the IAConfig.xml file found in <IAHOME>\conf and add the following line to the “service-configs” section:
<path>hpsmim-4-1/hpsmim.xml</path>
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4. Open the configuration.js file (now located in <IAHOME>\integrationservices\hpsmim-4-1\ folder, and set
the values for the following variables:

Variable Description

HPSM_URL The URL of the HP Service Manager web service.

HPSM_USER_NAME The user name of the HP Service Manager web service user used to access the
web services.

HPSM_PASSWORD_FILE Location of the file containing the web service user's password; for instructions
on how to set the password for this user, see "Installing the integration
service", below.

DEDUPLICATOR_FILTER The name of the filter used to suppress duplicate notifications for this
integration. For more information, see "Filtering and suppression" on page 36.

DELETE_EXISTING_EVENTS Sends a "delete" prior to creating the new event, which will clear any existing
events for the incident ID.

ANNOTATE_DELIVERY Updates incidents in HP Service Manager with xMatters notification delivery
status.

FORMS Maps each of the ticket types used in HP Service Manager to the
corresponding communication plan form's web service URL.

Note: You will need a web service URL for each form used in the integration.
For more information, see "Accessing web service URLs" on page 7.

ERROR_FORM Specifies the web service URL of the Error Alerts form, which is used to create
events in xMatters for any errors encountered while processing a user's
response.

INITIATOR Specifies the web login ID of a separate xMatters user for authenticating
REST API requests. The user (or its role) must have permission to access the
integration's forms via the REST API. For more information, see "Adding the
web service and REST API users" on page 6.

PASSWORD Specifies the location of the file containing the password of the xMatters
initiator user.

Note: This file must be created using the IAPassword utility as explained in
"Setting password files", below.

ENFORCE_CUSTOM_FIELDS Specifies whether to enforce the use of custom fields:

l If true, allow replies only if a user's custom fields are set. If a user does
not have the custom fields set, targeted notifications will have no
response options, and user's responses to group notifications will not be
processed.

l If false, and a user's custom fields are not set, the default HP Service
Manager credentials will be used to process the response.

The default is false.

For more information about setting custom fields, see "Defining custom fields"
on page 8.
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Variable Description

HPSM_LOGIN_CUSTOM_FIELD Specifies the name of the custom field that stores the user name for each user
accessing HP Service Manager. The default is HP SM Login.

HPSM_PASSWORD_CUSTOM_FIELD Specifies the name of the custom field that stores the password for each user
accessing HP Service Manager. The default is HP SM Password.

USE_DEFAULT_CREDENTIALS Specifies which credentials to use when processing responses:

If true, uses the user's custom credentials (the contents of the HP SM Login
and HP SM Password fields).

If false, uses the default HP Service Manager credentials provided in the
integration agent configuration.

The default is false.

INTEGRATED_PROPERTIES Specifies the mapping of properties returned by the HP Service Manager web
service to the integrated properties in xMatters.

5. Restart the integration agent.
l On Windows, the integration agent runs as a Windows Service; on Linux, it runs as a daemon.

2.4.8 Setting password files
This integration includes encrypted files, located in the <IAHOME>\conf folder, that stores the passwords for the web services
user required for the management system and the REST API user required by the xMatters REST API. You will need to
update the files with the correct password for the HPSM_USER_NAME and INITIATOR variables specified in the hpsmim-
4-1\configuration.js file.

Password file names:

l hpsmim.pwd stores the password for the HPSM_USER_NAME user used by the hpsmim-4-1 integration service.
l initiatorpasswd stores the password for the INITIATOR variable, or xMatters REST API user.

If you change the name of these files, you must also update the configuration.js file to point to the correct password files.

To specify a web service user password:

1. Open a command prompt, and then navigate to <IAHOME>\bin.
2. Run the following command, where <new_password> is the password for the web services user specified in the

configuration.js file, <old_password> is the existing password (the default value for a newly installed integration
is "password"), and <filename> is the name of the password file (hpsmim.pwd).

iapassword.bat --new <new_password> --old <old_password> --file conf/<filename>.pwd

To configure the xMatters REST API user password:

1. Open a command prompt, and then navigate to <IAHOME>\bin.
2. Run the following command, where <new_password> is the password for the INITIATOR user specified in the

configuration.js file, and <old_password> is the existing password (the default value for a newly installed
integration is "password"):

iapassword.bat --new <new_password> --old <old_password> --file conf/.initiatorpasswd
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2.4.9 Installing the synchronization configuration files
The xMattersSyncConfig.xml and xMattersSyncList.xml files contain the configuration information for synchronizing
users, groups, devices and coverages from HP Service Manager into xMatters.

Note that the synchronization process and all its files are identical for both the HP Service Manager Incident Management
and the HP Service Manager Change Management integrations; if you have already installed the HP Service Manager Change
Management integration (version 4.1), you can skip this step.

To install the synchronization configuration files:

Copy the files in the \components\servicemanager\config\ folder from the extracted integration archive to <SMHOME>.

Note: If these files are installed to a different location, you must modify the AlarmPointConfig script library within HP
Service Manager.

2.5 Configuring HP Service Manager
Configuring HP Service Manager to combine with xMatters requires the following steps:

n Import the xMatters tables and records.
n Modify the HP Service Manager triggers.
n Modify the AlarmPointConfig script.
n Add the SOAP API and xMatters capabilities to HP Service Manager User for xMatters web service calls.
n Update the IM.template.update and IM.update.incident forms to allow web service calls to update incidents.
n Expose the problem.type and product.type tables for web service calls.
n Remove the invalid data from HP Service Manager categories.
n Add the syncContact call to the createUser 2 Wizard.
n Enable Resolve for Web Services.

2.5.1 Importing xMatters tables, records, and web services
The xMatters tables, records, and web services are used to inject change requests to xMatters for notification, and required by
the HP Service Manager database for the integration.

The .sc files described in this section are shared between both HP Service Manager integrations; if you have already installed
the HP Service Manager Change Management integration (version 4.1), you should skip this step, unless you removed the
Incident Management triggers while installing the Change Management integration. If so, use the following steps to import
the xMattersTriggers.sc file.

To import the tables, records, and web services:

1. Log in to the HP Service Manager Client Console.
2. Open the Administration perspective.
3. In the System Navigator, open the Tailoring folder, and then double-click the Database Manager object.
4. In the drop-down menu in the upper-right corner of the main object window, select Import/Load.
5. Click the folder icon beside the File Name field.
6. Select the first .sc file in the \components\servicemanager\imports\ directory, in the extracted integration

archive.
7. Click Open.
8. Click Load FG.
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Repeat the above steps for each of the remaining .sc files in the imports directory.

Service Manager Unload scripts
This integration includes a set of HP Service Manager unload scripts intended to help with the maintenance of the
integration. The unload scripts are:

l AlarmPoint Forms: This script unloads all the capability words, dbdict definitions, displayoptions, displayscreens,
formats, globallists, menus and scripts associated with the integration.

l AlarmPoint Integration: This unload script is a combination of the Forms, ScriptLibrary, Triggers, Unload and Web
Services unload scripts.

l AlarmPoint Purge: This unload script is similar to Integration, but instead of an unload this script performs a purge
l AlarmPoint ScriptLibrary: This unload script unloads the xMatters Java Scripts found in Script Library
l AlarmPoint Triggers: This unload script unloads the xMatters triggers associated with the integration.
l AlarmPoint Unload: This unload script unloads the unload scripts.
l AlarmPoint Web Services: This unload script unloads the External Access Definitions needed as part of the integration.
Note that this does not unload a comprehensive list of the External Access Definitions that are required; it is an unload
of the definitions which are unique to the integration and created to support the integration. Definitions such as
xMIncidentManagement, which are updated to support the integration, must be managed manually.

2.5.2 Modifying the HP Service Manager triggers
Importing the xMattersTriggers.sc file loads all of the triggers for both of the xMatters for HP Service Manager
integrations. If you want only the HP Service Manager Incident Management integration (i.e., you are not installing the HP
Service Manager Change Management integration), you should delete the triggers specific to the other integration.

To delete the triggers:

1. In the HP Service Manager Database Manager's Form field, type triggers, and then press Enter.
2. In the Trigger Name field, type alarmpoint and then press Enter.
3. Locate and delete the following triggers:

l alarmpoint.after.add.change
l alarmpoint.after.update.change

2.5.3 Modifying the AlarmPointConfig script
The AlarmPointConfig script contains configuration information for web services, data synchronization, and other parameters
as described in the table below. This section describes how to modify the configuration script to allow HP Service Manager
to inject incidents to xMatters through web services.

Note: The configuration files described in this section are shared between both HP Service Manager integrations; if you
have already installed the HP Service Manager Change Management integration (version 4.1), you can skip this
step.

To modify the AlarmPointConfig script:

1. In HP Service Manager System Navigator, open the Tailoring folder, and then double-click the Script Library object.
2. In the Name field type AlarmPointConfig, click Search.
3. Modify the variables in the following table to suit the configuration of your integration.
4. Click Save, Compile, and then Execute.

l If HP Service Manager returns any errors after you click Compile, ensure that you have updated the file correctly.
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Variable Name Value

web_service_url The URL of the xMatters web service; for example:
"http://localhost:8888/api/services/AlarmPointWebService";

web_service_user The user name of the xMatters web service user (as configured in "Adding the
web service and REST API users" on page 6). Best practices suggest that the
user name be related to the purpose; e.g., "hpsm-xmwsu".

web_service_password The password of the xMatters web service user.

xmatters_servicemanager_im_domain The name of the xMatters event domain and integration service for Incident
Manager notifications; e.g., "applications\hpsmim-4-1".

default_xmatters_admin_group The target name of the recipient (group or user) in xMatters where
synchronization error notifications are sent.

Note: If a group has a synchronization error and that group has a supervisor,
the group supervisor will be notified instead of this recipient.

send_sync_error_notifications If true, sends notifications to the default administration group created in
"Creating an admin group" on page 9 (or the group supervisor) when a record
fails to synchronize with xMatters.

xmatters_servicemanager_sync_domain The xMatters event domain for Service Manager. The value initializes the
variable using an existing variable value, and should not include quotes.

Note: If you are installing ONLY the HP Service Manager Change
Management integration, change the variable name to:
xmatters_servicemanager_cm_domain

sm_home The location of the HP Service Manager installation; for example:

"C:\\Program Files (x86)\\HP\\Service Manager 9.30\\Server\\"

sm_user The HP Service Manager user used by the integration agent to update tickets
in HP Service Manager; should match the HPSM_USER_NAME configured
in the configuration.js file as described in "Installing the integration
service" on page 9.

config_file The location of the xMattersSyncConfig.xml; for example:
sm_home + "xMattersSyncConfig.xml"

synclist_file The location of the xMattersSyncList.xml; for example:
sm_home + "xMattersSyncList.xml"

ia_url The URL of the integration agent HTTP listener; for example,
http://localhost:2010/agent

Note: If the integration agent is installed on the same computer as HP Service
Manager, you do not need to modify this parameter.

xmatters_company Name of the company within xMatters; the default value is “Default
Company”.

AlarmPointConfig script variables
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Variable Name Value

sync_voice If true, voice devices will be synchronized; the default is true.

detailedSyncLogging If true, displays filtering information when performing a synchronization;
default is true.

detailEventLogging If true, displays the APXML being sent to xMatters; default is false.

sync_cm3groups If true, synchronize HP Service Manager Change groups when performing a
synchronization; default is true.

sync_assignmentGroups If true, synchronize HP Service Manager Assignment groups; default is true.

assignmentGroupSuffix Specifies the string to add to the end of HP Service Manager Assignment
group names when synchronizing.

Note: This suffix prevents possible name collisions between Assignment and
Change groups, which can have the same name in HP Service Manager, but
must have unique names in xMatters.

changeGroupSuffix Specifies the string to add to the end of HP Service Manager Change group
names when synchronizing. (See note above for more information)

2.5.4 Adding capabilities to users
The integration requires all users who are going to respond to notifications through xMatters to have both the "SOAP API"
and "AlarmPoint" capabilities in addition to the appropriate xMatters configuration as described in "Configuring users" on
page 8. These users can update and annotate HP Service Manager incidents from xMatters through web service calls.

To add the required capabilities to a user:

1. In the HP Service Manager System Navigator pane, expand the System Administration > Ongoing Maintenance
folders, and then double-click the Operators item.

2. In the Login Name field, type the login name of the user to whom you want to give response capabilities, and then
click Search.

l The default configuration of the xMatters Action Scripts uses the default HP Service Manager user “falcon” to
make web service calls; if you want to use a different user, you must update the Action Scripts accordingly. For
more information, see “Configuration Variable Reference” on page 54.

3. Select the Startup tab.
4. Under Execute Capabilities, if not already listed, add SOAP API and AlarmPoint.
5. Click Save.

xMatters may now use web service calls to connect to this HP Service Manager user.

2.5.5 Updating the Incident Manager form
The IM.update.incident form must be modified to allow xMatters web service calls to update incidents.

To modify the form:

1. In HP Service Manager System Navigator, open the Tailoring folder, and then double-click the Format Control
object.

2. In the Name field type IM.update.incident, and then click Search.
3. Click Subroutines.
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4. Right-click on the page, and select Show Expanded Form.
5. Scroll down to the section with an Application Name of script.execute.
6. Modify the Update field to contain the following:
problem.status in $file="Rejected" and gui()=true

7. Click Save.

2.5.6 Add the syncContact call to the createUser 2 Wizard
The AlarmPointUser.syncContact call must be added to the createUser 2 Wizard to enable synchronization of users upon their
creation.

Note that while HP Service Manager’s User Quick Add Utility has space for both first and last names, the xMatters
synchronization parses the first word (up to the first space) within the Full Name field as the first name, and adds any
remaining words to the last name. For example, if a user was added in HP Service Manager with a first name of “One Two”
and a last name of “Three Four”, xMatters would parse the entry as first name “One” and last name “Two Three Four”.

Note: If you have already installed the HP Service Manager Change Management integration, you do not need to perform
this step.

To add the syncContact call:

1. In the HP Service Manager System Navigator pane, in the Tailoring folder, double-click Wizards.
2. In the Wizard Name field, type createUser 2 (case sensitive), and then click Search.
3. Click the Actions tab, and then click the Javascript tab.
4. Add the following line to the end of the Javascript:
system.library.AlarmPointUser.syncContact(vars.$contactname);

5. Click Save.

Now when a user is created in HP Service Manager using the createUser 2 Wizard, they will be automatically synchronized
with xMatters.

Note that in HP Service Manager, Login IDs are case sensitive; for example, “FALCON” and “falcon” represent two separate
users. In xMatters, User IDs (the equivalent to Login IDs in HP Service Manager) are case insensitive: xMatters would not
recognize “FALCON” and “falcon” as belonging to different Users.

2.5.7 Adding the syncContact call to the Process record
For the contact.do.save call to properly synchronize user information with xMatters, the AlarmPointUser.syncUser call must
also be added to the Process record.

Note: If you have already installed the HP Service Manager Change Management integration, you do not need to perform
this step.

To add the syncContact call:

1. In the HP Service Manager System Navigator pane, click Tailoring > Database Manager.
2. In the Table field, type Process, and then click the Search button.
3. On the Process Definition form, in the Process Name field, type contacts.do.save, and then click the Search button.
4. Click the Final JavaScript tab.
5. Add the following line to the JavaScript:
system.library.AlarmPointUser.syncUser(record, oldrecord);

6. Click Save.
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2.5.8 Enabling Resolve for web services
You must modify the environment to allow Resolve to work with web services.

To enable Resolve for web services:

1. In HP Service Manager, expand the Incident Management > Administration folders, and then double-click
Environment.

2. In the Incident Management Environment details, select the Use Resolved Status check box.
3. Save your changes, and log out of HP Service Manager.

2.6 Configuring Synchronizations
The xMatters for HP Service Manager Incident Management integration supports one-way synchronization of groups (both
assignment and change groups in HP Service Manager), teams, users, devices and coverages from HP Service Manager into
xMatters. To enable synchronization and customize it to your business behavior, two configuration files are provided:
xMattersSyncConfig.xml and xMattersSyncList.xml.

Modify these files according to your desired business behavior; the following sections provide an overview of these files and
their configuration options.

Note: If you have already installed the HP Service Manager Change Management integration, you do not need to perform
this step.

Synchronization Troubleshooting
When performing a synchronization, open the HP Service Manager messages panel. This allows you to see successful
completion of synchronizations such as modifying groups, group memberships, users, and user devices. Alternatively, you can
use the Sync Report under the Menu Navigation xMatters entry to determine if any errors occurred after synchronization.

2.6.1 Synchronization configuration file
The xMattersSyncConfig.xml file defines the synchronized values for groups, teams, users, devices and coverages. The file
included with the integration has default values to use for each object type, but can be customized to use different values for
a specific instance of an object.

Note that in HP Service Manager, Login IDs are case sensitive; for example, “FALCON” and “falcon” represent two separate
users. In xMatters, User IDs (the equivalent to Login IDs in HP Service Manager) are case insensitive: xMatters would not
recognize “FALCON” and “falcon” as belonging to different users.

Note: If have already installed the HP Service Manager Change Management integration, you do not need to perform this
step.

Default values
Each default element must specify a value for all possible fields (refer to the following section for a complete list of possible
fields). Each default element must also specify the seedOnly and deletable attributes.

If the seedOnly attribute is true, then that object will only be added to xMatters when it is initially synchronized and will no
longer be updated. If the seedOnly attribute is false, any modifications to the object done in xMatters will be overwritten
when that object is updated in HP Service Manager.

If the deletable attribute is true, then that object will be removed from xMatters when it is deleted from HP Service Manager;
otherwise, it will remain in xMatters indefinitely and must be deleted manually.

The following elements must exist in the xMattersSyncConfig.xml file:
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l default-user
l default-email
l default-work-phone
l default-home-phone
l default-sms-phone
l default-assignment-group
l default-change-group
l default-team
l default-coverage

By default, all objects are deletable and set to seedOnly = false.

There are three different ways that you can specify a default value to synchronize with xMatters:

1. Set a default value for a field:
l default: the value for this field

For example, the role for the following will be standard user unless it is overridden:
<role default="standard user"/>

2. Use a regular expression to extract a value from a field:
l default: the default value for this field if the regular expression does not match
l field: the column in this table to apply the regular expression
l regex: the regular expression used to extract a value
l index: when you use Groups, this is the index of the Group you want to use (where the first Group is 1)

For example, the area-code for the following will be the first submatch when the '\D*(\d{0,3})\D*([0-9]{1}[0-9., -]+)\D*'
regular expression is applied to the contact_phone field
<area-code field="contact_phone" regex="\D*(\d{0,3})\D*([0-9]{1}[0-9., -]+)\D*" index="1"/>

3. Map a field’s value to a desired value:
l default: the default value to use if there is no match
l map Element: the field attribute specifies the column in the table to match; the value attribute specifies the value
of the field to match on; and, the text of this field is the value to be saved

For example, the language for the following will be English, unless the value of the language column in the record is either
de or fr:
<language default="English">
<map field="language" value="de">German</map>
<map field="language" value="fr">French</map>

</language>

Object-specific values
All object-specific elements will override any default value element and can override the seedOnly and deletable attributes.

Field Description Possible Values

active Whether this user is active true, false

first-name User’s first name Any string

default-user Fields
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Field Description Possible Values

last-name User’s last name Any string

has-mobile-access Mobile access flag true, false

site User’s site Valid xMatters site name

language User’s language Valid xMatters language

timezone User’s time zone Valid xMatters time zone

role User’s xMatters role A comma-delimited list of valid xMatters roles.

supervisor User’s xMatters supervisor Valid xMatters user target name. If the
supervisor in HP Service Manager is not a valid
User in xMatters, the synchronization for the
user/group will fail.

has-phone-login Phone login flag true, false

phone-login User’s phone login Unique string containing only digits

phone-password User’s phone password String containing only digits

ldap-domain User’s web login LDAP domain Valid xMatters LDAP domain

web-login User’s web login Unique web login

web-password User’s web login password Any string

web-login-type Defines whether the web login is a
native xMatters login or an LDAP
authentication

NATIVE, LDAP

externally-owned Indicates whether the user is externally-
owned

true, false

custom-field-name The name of the custom field in xMatters
that will contain the value of SM userId
to be used by xMatters notification
responses.

Any string. Default is “HP SM Login”

custom-field-value The value to use in the custom field
defined in the custom-field-name field.

Any string

Field Description Possible Values

name Device name (must match a device name configured in
xMatters)

Valid xMatters email device
name

active Whether this device is active (i.e., available to receive
notifications.

true, false

default-email Fields
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Field Description Possible Values

default Whether this device should be used as the user’s default
device

true, false

delay Device’s delay setting Integer value (time in
minutes)

externally-owned Indicates whether the device is externally-owned true, false

priority-threshold Device’s priority threshold LOW, MEDIUM, HIGH

user-service-provider-id ID of the user service provider (is ignored if the user-
service-provider-name is present)

Long

user-service-provider-name Name of the user service provider (takes priority over
provider ID)

Valid xMatters User Service
Provider name

address Device’s email address Valid email address

Field Description Possible Values

name Device name (must match a device name configured in
xMatters)

Valid xMatters email device
name

active Whether this device is active true, false

default Whether this device should be used as the user’s default
device

true, false

delay Device’s delay setting Integer (time in minutes)

externally-owned Indicates whether the device is externally-owned true, false

priority-threshold Device’s priority threshold LOW, MEDIUM, HIGH

user-service-provider-id ID of the user service provider (is ignored if the user-
service-provider-name is present)

Long

user-service-provider-name Name of the user service provider (takes priority over
provider ID)

Valid xMatters User Service
Provider name

area-code Device’s area code String containing only digits

country-code-override Device’s county code Valid two letter country code

extension Device’s extension String containing only digits

number Device’s phone number String matching [0-9]{1}[0-9.,
-]+

default-work-phone, default-home-phone, and default-mobile-phone Fields
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Field Description Possible Values

name Device name (must match a device name configured in
xMatters)

Valid xMatters email Device
name

active Whether this device is active true, false

default Whether this device should be used as the user’s default
device

true, false

delay Device’s delay setting Integer (time in minutes)

externally-owned Indicates whether the device is externally-owned true, false

priority-threshold Device’s priority threshold LOW, MEDIUM, HIGH

user-service-provider-id ID of the user service provider (is ignored if the user-
service-provider-name is present)

Long

user-service-provider-name Name of the user service provider (takes priority over
provider ID)

Valid xMatters User Service
Provider name

number Device’s phone number String containing only digits

default-sms-phone Fields

Field Description Possible Values

description Group’s description Any string

timezone Group’s time zone Valid xMatters time zone

site Group’s Site Valid xMatters site

active Whether this group is active true, false

allow-duplicates Allow duplicates flag true, false

externally-owned Externally owned flag true, false

observed-by-all Observed by all flag true, false

observer Target name of a user to be the group’s observer Valid xMatters user target name

supervisor Target name of a user to be the group’s supervisor Valid xMatters user target name

use-default-device Use default device flag true, false

default-assignment-group and default-change-group Fields

Field Description Possible Values

name Team name Any string not containing ‘|’

description Description for the team Any string

default-team Fields
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Field Description Possible Values

externally-owned Externally owned flag true, false

reuse Reuse team flag true, false

rotation-interval Rotation interval (only used if type is ROTATION) Integer value (time in minutes)

rotation-start Rotation start date (only used if type is
ROTATION)

Date in the format

‘dd/mm/yyyy h:mm:ss AM/PM’

rotation-unit Rotation units (only used if type is ROTATION) DAYS, MONTHS, WEEKS

type Team type BASIC, EVENT_ROUND_ROBIN,
ROTATION

member-type Team member type (should leave as PERSON for
the integration)

PERSON, GROUP, TEAM, DEVICE

member-delay Delay between team members Integer value

member-in-rotation Are group members in the rotation true, false

Field Description Possible Values

name Coverage name 24/7 Any string not containing '|'

start-time Start time for this shift Time in the format "hh:mm"

duration-hours Duration of the shift in hours Integer value 0 <= N <= 24

duration-minutes Duration of the shift in minutes (added to duration in
hours)

Integer value 0 <= N <= 60

exclude-holidays Exclude holidays flag true, false

sunday Coverage on Sunday true, false

monday Coverage on Monday true, false

tuesday Coverage on Tuesday true, false

wednesday Coverage on Wednesday true, false

thursday Coverage on Thursday true, false

friday Coverage on Friday true, false

saturday Coverage on Saturday true, false

recurrence-end-date End date for the coverage Time in the format

dd/mm/yyyy h:mm:ss AM/PM

default-coverage Fields
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Field Description Possible Values

recurrence-frequency Frequency of the recurrence DAILY, WEEKLY,
MONTHLY

recurrence-interval Interval of the recurrence Integer value

recurrence-no-end-date No end date flag true, false

recurrence-occurences Number of recurrences for this coverage Integer value

recurrence-start-date Start date of the recurrence Time in the format

dd/mm/yyyy h:mm:ss AM/PM

2.6.2 Synchronization list file
The xMattersSyncList.xml file is used to define which operators and assignments should be synchronized with xMatters.
The XML file contains a list of user elements with a name attribute matching an operator ID and a list of group elements
containing a name attribute matching an assignment name.

The user and group elements have an action attribute which tells the integration whether you want to include only the user
and group in the list for synchronization and exclude all other users and groups, or whether you want to exclude the user and
group in the list for synchronization and include everyone else. The following is an example of what the file would look like
if you want to synchronize only the TELECOMS assignment and want to synchronize all the operators except for FALCON:
<synclist>
<users action="exclude">
<user name="FALCON"/>

</users>
<groups action="include">
<group name="TELECOMS"/>

</groups>
</synclist>

2.7 Configuring the Sync Report form
This integration includes the custom HP Service Manager Sync Report form.

The Sync Report can begin full system synchronization and view the last status of objects synchronized with xMatters. The
behavior of the page is as follows:

l Click Show Errors to display all synchronization records that are currently in an error state.
l Click Show All to display all synchronization records.
l Select Sync Now to initiate an attempt to synchronize the entire system.
l Click Filter to display all synchronization records that match the specified filter criteria. These filter fields use the
StartsWith operator.

2.7.1 Adding buttons and menus to the Sync Report form
The alarmpoint.syncreport scripts provided with the integration can be used with the script.execute RAD application.

To add menu items:

1. In Service Manager, open Menu Navigation > Tailoring > Tailoring Tools > Menus.
2. In the Menu Name field, type the name of the appropriate menu for your deployment (e.g., HOME), and then click
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Search.
3. Add the following values to the table:

Option Number Description Application Parameter Value Condition

Next available
number

xMatters menu.manager name AlarmPoint
MAIN

index("AlarmPoint",
$lo.ucapex)>0

Note: Ensure that you record the Option Number assigned to each button and menu, as you will need to reference these
numbers when adding the custom form buttons in the next section.

4. Click Save, and then click Save again.
l If you receive an error message after clicking Save the first time, you can safely ignore it.

5. Refresh the System Navigator.

You should now see a new xMatters navigation group in the System Navigator with separate entries for each custom form.

Note: The buttons and menu items are visible only to users with the "AlarmPoint" capability. For information about how
to add the capability, refer to "Adding capabilities to users" on page 15.
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Chapter 3: Integration Validation
After configuring xMatters and HP Service Manager, you can validate that communication is properly configured.
The following sections explain how to test the combination of xMatters and HP Service Manager for notification
delivery and response, subscription functionality, and synchronization configuration.

3.1 Validating User and Group Synchronization
The following validates that communication from HP Service Manager to xMatters for user and group
synchronization is properly configured.

Note that the user and group synchronization process is handled via direct web service calls between xMatters and
HP Service Manager; synchronization relies upon the correct configuration of the web services user, as described in
"Adding the web service and REST API users" on page 6

To test the User and Group Synchronization:

1. Edit the <SMHOME>\xMattersSyncList.xml file as follows:
<synclist>
<users action="include">
</users>
<groups action="include">
</groups>

</synclist>

2. Restart your HP Service Manager client.
3. Add a new Operator to HP Service Manager:

l In HP Service Manager, open Menu Navigation > System Administration > Ongoing Maintenance >
User Quick Add Utility.

l Specify the required information.
l Click Next, Finish, and then OK.

4. In HP Service Manager, open Menu Navigation > System Administration > Ongoing Maintenance > Groups
> Incident Management Assignment Groups.

5. Type the name of the assignment group you want to use for testing purposes (eg. TESTSYNC).
6. Select the Operators tab, add the operator you just created, click Add, and then click OK.
7. Edit the xMattersSycnList.xml file to look like the following (replace operatorname and

assignmentname with the operator and assignment group you just created):
<synclist>
<users action="include">
<user name="operatorname"/>

</users>
<groups action="include">
<group name="assignmentname"/>

</groups>
</synclist>

8. Restart the Service Manager client.
9. Open the custom Sync Report form (see "Adding buttons and menus to the Sync Report form" on page 23 for

instructions how to add a menu item for this).
10. In the drop-down list in the upper right, select Sync Now.

l This should synchronize the operator and assignment that you just added to HP Service Manager into
xMatters as a User and Group.
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11. Log in to xMatters to check that the user and group was properly synchronized.

Note: The xMatters User target name is the HP Service Manager contact’s operator ID and the xMatters Group name is
the HP Service Manager assignments name.

3.2 Triggering a notification
In this example, an event will be injected to xMatters for notification to the group configured in the user and group
Synchronization example.

1. In Service Manager, open Menu Navigation > Incident Management > Open New Incident.
2. Specify the following values in the required fields:

l Primary Asgn Group: the Assignment group you just synchronized with xMatters.
l Urgency: either 1 - Critical, or 2 - High.

3. Enter values for all other required fields:

4. Click Submit.

This should inject the incident parameters into xMatters, triggering a new subscription notification -- if you have created a
subscription.

3.3 Responding to a notification
This section describes how to respond to a notification from xMatters. In the following example, the notification is received
on a mobile phone, but the process is similar for all devices.

To respond to a notification:

1. When a notification arrives, open it to view its details:
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2. Scroll down to view all of the response choices:
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3. To respond to a notification, click a response choice, and xMatters sends the response:

For more information about response choices, and changing the options available to users, see "Response choices" on page
34.
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3.4 Viewing response results
When an action is taken on an xMatters notification, that action is reflected in the original incident. When xMatters makes
changes to a ticket, it also updates the Historic Activities field on the incident.

To view the notification results:

1. In Service Manager, open Menu Navigation > Incident Management > Search Incidents.
2. In the Incident ID field, type the ID of the incident you want to view, and then click Search.
3. Scroll down to the Activities section to view the updates:

For each user device notified during this process, the Journal Updates log will be annotated with a message indicating
“Successful Delivery for bsmith|Work Email” where “bsmith|Work Email” is the recipient (<userID>|<deviceName>).
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Chapter 4: Optimizing and Extending the Integration
This section describes some of the available methods you can use to optimize or extend the xMatters for HP Service
Manager Incident Management integration.

4.4 Configuring integrated properties
This version of the integration supports integrated properties and includes a sample communication plan you can use
to demonstrate and test this feature.

This plan is not required for the feature to work and is provided only as an example; to add integrated properties to
an existing communication plan skip to Step 2.

Step 1: Import the sample plan
This integration includes a sample plan containing a simple form that you can use to manually create notifications
with a custom "escalation message" property and incident data retrieved from HP Service Manager.

To import the sample communication plan:

1. Log in to xMatters, and click the Developer tab.
2. On the Communication Plans page, click Import Plan.
3. In the Import Communication Plan File dialog box, click Choose File, and then locate the

\components\xmatters\plans\HPSMIMIntegratedProperties.zip file extracted from the integration
archive.

4. Click Open, and then click Import Plan.
5. Click Plan Disabled to enable the plan.
6. In the Edit drop-down list, select Forms.
7. In the HP SM IM Integrated Properties form, in the Not Deployed drop-down list, click Form.

l After you deploy the form, the drop-down list label will change to "Form Only".
8. In the Form Only drop-down list, click Permissions.
9. Enter a user or group that will have permission to send messages using this form, and then click Save

Changes.

Step 2: Defining the integration service
For the installation to be successful, the integration service names must match the names specified in the
hpsmim.xml file installed on the integration agent.

To define an Integration Service:

1. In xMatters, on the Event Domains page, click the applications event domain.
2. On the Event Domain Details page, in the Integration Services area, click Add New.
3. Enter the following information into the form:

l Name: hpsmim-4-1
l Description: HP Service Manager Integration Service
l Path: Not required.

4. Click Save.
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Step 3: Configure the integrated properties
Once you have imported the sample plan and created the integration service, you can set up the integrated properties for your
integration. (Integrated properties are not included in exported communication plans; they must be manually configured.)

Note: For more information about configuring integrated properties, click the Help button on the Integrated Properties
tab in xMatters.

To configure the integrated properties:

1. In xMatters, on the HP SM IM - Integrated Properties plan, click the Integrated Properties tab, and then click Create
Integrated Properties.

2. In the Create Integrated Properties dialog box, in the Name field, type Incident Details, and then click Create
Integrated Properties.

3. Click Edit beside the new integrated properties.
4. On the Incident Details page, enter the following information:

5. Click the Create a request property button, and then select Text from the drop-down list.
6. In the Create a new Text property dialog box, in the Name field, type Incident ID, and then click Create request

property.
7. Click the Create a response property button to add a response property; the table below describes the default

properties supported by the integration.
l You can create all of your response properties for the sample form as text properties, but make sure you modify
the Maximum Size for each property to account for longer fields such as Description.

8. When you have finished adding properties, click Save Changes.
9. To check your configuration, click Send Test Request and inspect the returned data.
10. Once you are satisfied with your changes, click the Forms tab, and then click Edit > Layout for the HP SM IM

Integrated Properties form.
11. On the Layout tab, drag the Incident Details section from the Integrated Properties section and drop it onto the form

layout.
12. Click Save Changes.
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Available properties
The names of the properties must match the names returned by the handleGetIncident() function defined in the integration's
hpsmim-properties.js file. By default, this function uses the INTEGRATED_PROPERTIES variable defined in
configuration.js to map XML elements returned by HP Service Manager web service to property names. Elements not
found in the INTEGRATED_PROPERTIES variable are included as is. You can edit the handleGetIncident() function to
modify this behavior.

The following response properties are supported by default.

Name Example Value

Category incident

Opened On 2014-10-05T13:30:27+00:00

Opened By System.Admin

Updated On 2014-11-11T22:08:49+00:00

Description VPN Issue

Title User cannot remote access the intranet

Updated By falcon

Status Categorize

Phase Categorization

Area failure

Subarea function or feature not working

Urgency 3

Impact 3

Affected Service Intranet / Internet (North America)

You can choose to include only a subset of properties; in this case, xMatters ignores the remaining properties returned by the
integration and does not display them to users.

Step 4: Send a test message.
You can now create the message content and send a test notification that includes the integrated properties.

To add the integrated properties to message content:

1. On your communication plan form, click the Messages tab.
2. Click Edit for each message type to which you want to add integrated properties.
3. In the message builder, drag the properties you want to include from the integrated properties section on the right and

drop them into the message.pane.
l Voice messages are constructed differently than email and text messages; for more information about working
with voice messages, click the Help button at the top of the page on the Messages tab.

4. Click Save Changes.

You are now ready to send a test message containing the integrated properties.
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To send a test message:

1. Click the Messaging tab, and click the name of the form with the integrated properties.
l If you imported the sample communication plan, the form is named HP SM IM Integrated Properties.

2. On the form, in the Recipients section, specify a user (or device) whose notifications you can access.
3. Type a brief message in the Escalation Message field.
4. In the Integrated Properties section, in the Incident ID field, type the ID for an active incident in your system, and then

click Search.
l xMatters will automatically populate the fields with the details of the specified incident. You can modify these
details before sending the message, but your changes will not be reflected on the associated incident.

5. Click Send Message to send a test message to the specified recipient.

The test message will include both the escalation message and the incident details retrieved from HP Service Manager.
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4.1 Adding new parameters
Additional data elements (or tokens) can be forwarded to xMatters by adding them in HP Service Manager. The following
steps explain how to add a new event token to the event injected to xMatters.

To add an event token:

1. In HP Service Manager, click Menu Navigation > Tailoring > Script Library.
2. In the Name field type AlarmPointEvent, and then click Search.
3. Find the addEvent function.
4. Locate the util.addAPXMLData section.
5. Within the section, insert a new line using the following syntax:
util.addAPXMLData(apxml, "token_name", "string", record.action, true);

Where:
l token_name: a descriptive name for the new event token.
l string: the data type.
l record.action: "record" is the incident record, and "action" is the field name in HP Service Manager.

6. Click Save.

To help illustrate how this appears in HP Service Manager, the following image was provided by an xMatters consulting
partner:

To view a description of the field information for your parameter, click Window > Preferences > Expand HP Openview
ServiceManager > Appearance, and then select the Show context-sensitive help debug information check box. Place your
cursor in the field, and then press Ctrl-H.

4.1.1 Adding new tokens to notification content
Once you have injected the new data elements, you can add the token as a property to the communication plan and the
appropriate forms in xMatters. Once the property is added to the form's layout, you can add it to the message content for
various devices. For more information about these processes, refer to the xMatters On-Demand help, accessible from within
the web user interface.

4.2 Response choices
This integration allows recipients to respond to notifications with several default choices, some of which are injected back to
the HP Service Manager server, updating the original incident. Users notified on email devices also have the ability to
respond with an extra annotation message which will be logged in the original HP Service Manager incident.

The following is a list of the default response choices available with the integration and their associated actions on the
xMatters event and the incident.
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Response xMatters Action HP Service Manager Update Availability

Own Delinks all users other than the
responder from the event, not
allowing them to submit responses.
The owner will not be notified
further, but has the ability to affect
the event by responding on one of
their devices or from the browser. For
example, a user owns the event in
xMatters, and then closes the event.
They may also annotate the owned
event.

The status for the incident is changed
to Work In Progress and the incident
is assigned to the responder. Any
additional notes added to the
response are recorded on the
incident’s Journal Updates.

All non-FYI devices

Escalate Signifies that the user wants to
escalate the notification.

All non-FYI devices

Resolve Delinks all users from the event, not
allowing them to submit responses.

The ticket status is updated to
Resolved and any additional notes
added to the response are recorded on
the incident’s Journal Updates.

All non-FYI devices

Default response choices

4.2.1 Customizing the responses in the integration agent
If you change the wording of the existing response options in the xMatters forms, you must also update the corresponding
RESPONSE_ACTION constants in the configuration.js file.

If you are adding a new response option that needs to be processed by HP Service Manager, update the handleResponse
function in the hpsmcm-callbacks.js file with implementation for the new option.

4.2.2 Adding annotation messages
Two-way email Device notifications (not FYI) can add extra annotations that will be added to the incident as a message on
the Journal Updates tab. To add an extra annotation, respond to an email notification with the following format in the subject
line:
RESPONSE <Choice> <Message>

<Choice> can be any of the response choices listed in the table above, and <Message> can be any content you want to add
as the annotation.

4.2.3 Responses for sync errors
Sync Error notifications are based on the Sync Error Alert form. These create an event within xMatters and the available
responses do not have any effect on the HP Service Manager system.

4.3 Delivery Annotations
This integration extensively annotates the originating HP Service Manager incident for each device to which a notification is
delivered, but this may not be desirable in all environments. To prevent the delivery annotation of a change request, change
the "ANNOTATE_DELIVERY" constant in the configuration.jsp file to false.
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4.4 Adding custom trigger rules
To add a custom trigger rule that will trigger a notification to be injected into xMatters:

1. Click Menu Navigation > Tailoring > Script Library.
2. Type AlarmPointEvent in the Name field.
3. Click Search.
4. Modify the following methods to suit your requirements:

l getTriggerRule() - This method is used to determine whether a notification should be injected into xMatters.
l getDeviceFilter() - This method is used to return a device filter string that will limit the devices to which that
notification will be sent.

l getRecipients() - This method returns a list of recipients that this notification should target in the format
'recipient1, recipient2, …'

For example, the default behavior is to inject a notification into xMatters only upon incident creation when the urgency is
either critical or high. To modify this to always inject a notification on creation, change the following lines

From:
else{
if(record.severity <= 2)
triggerRule = "Assignment";

}

To:
else{
triggerRule = "Assignment";

}

4.5 Filtering and suppression
The xMatters integration agent's Portable Filtering and Suppression Module is a built-in module that maintains a rolling
record of previously injected events, and allows for the suppression of duplicates (also referred to as "deduplication"). This
helps avoid disruption of traffic due to inadvertent loads that can result when, for example, improperly configured
management systems inject duplicated events.

The deduplicator-filter.xml file is installed in the <IAHOME>\conf folder and is configured to suppress duplicate events
for 30 minutes (up to a maximum of 100 events in that period).

This filter can be modified to extend the time period over which an event is considered to be a duplicate, the number of
events in that period and the tokens that are used to determine what makes the event unique.

For example, to add NEW_VALUE_NAME to the tokens, open the deduplicator-filter.xml file in a text editor and add
the following line to the <predicates> collection:
<predicate>NEW_VALUE_NAME</predicate>

Save the file and restart the integration agent for the changes to take effect.

Note: To see a complete list of predicates available in the integration, review the Event Data in the Event Summary
Report in the xMatters web user interface.
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4.6 HP Service Manager logging
All of the integration actions and errors are printed out to the messages panel and logged to the standard HP Service Manager
log file specified in the sm.ini configuration file. These messages are defined in the AlarmPointUtil script library and are in
the following format:
var RECIPIENT_UPDATE_FAIL = "Failed updating xMatters %% %% - %%";

Messages are displayed using the following function:
logMessage(messageId, <args>)

where messageId matches the variable used to define the message and <args> is replaced by as many arguments as you
want. These extra arguments are used in order to replace all occurrences of %% in the defined message.

For example, to log the message ‘Failed updating xMatters Team TELECOMS-24x7 - UNKNOWN_GROUP’, you would use
the following:
logMessage("RECIPIENT_UPDATE_FAIL", "Team", "TELECOMS-24x7", "UNKNOWN_GROUP");

This would print in the Service Manager log file as:
3204(  2656) 12/04/2007 11:15:26 JS I Failed updating xMatters Team TELECOMS-24x7 - UNKNOWN_
GROUP

4.7 Uninstalling
For instructions on removing an xMatters deployment, refer to the xMatters installation and administration guide.

This integration does not include an uninstall utility; you must remove the installed components manually. For a list of the
components, see "Configuring xMatters" on page 5
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